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CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent



Finalizing Design Intent



Student Notes:



In this lesson you will learn how to analyze a model and create formulas.



Lesson Contents:



Copyright DASSAULT SYSTEMES



Case Study: Finalizing Design Intent Design Intent Stages in the Process Apply Material Properties Analyze the Model Create Formulas and Parameters



Duration: Approximately 0.5 day
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Case Study: Finalizing Design Intent



Student Notes:



Copyright DASSAULT SYSTEMES



The case study for this lesson is the table used in the Drill Support assembly as shown below. The table is part of the Stand sub-assembly. This case study focuses on applying material to the model, analyzing its mass properties, verifying dimensions, and creating formulas to ensure that the design intent is maintained when the modifications are applied.



Copyright DASSAULT SYSTEMES



7-2



CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent Student Notes:



Design Intent (1/2) The table must meet the following design intent requirements: The model must be made of aluminum. • The material selected for this part is aluminum. The material properties of aluminum in the CATIA library will meet the requirements.



Model geometry must adhere to the following criteria (which can be verified using measurement tools and enforced using formulas):



a



L



a. Create a hole that is always 2mm above the bottom oblong holes and is centered horizontally. b. Overall width must be 80% of the length (L).
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Design Intent (2/2) Model geometry must adhere to the following criteria (continued): c. The thickness of the model is always 1% of the length (L). d. The thickness of the ribs is two times the thickness of the model. d c
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Stages in the Process



Student Notes:



Use the following steps to finalize the design intent:
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1. Apply material properties. 2. Analyze the model. 3. Create formulas.
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Apply Material Properties In this section you will learn how to apply and view material on your model.



Use the following steps: 1. Apply material properties.
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2. Measure the model. 3. Create formulas and parameters
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Material Properties



Student Notes:



Copyright DASSAULT SYSTEMES



Material can be applied to any part in CATIA. The material properties (e.g., density) affects the mass properties of the part. CATIA has a default library of materials already installed. Your company may have custom materials created to conform to your requirements.
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Applying Material Properties (1/2) To apply a material to a model, use the following steps:
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1. Select the part in the specification tree 2. Click the Apply Material icon. 3. Select the material (e.g., Aluminum from the Metal tab). 4. Select Apply Material. 5. Click OK. The material is added to the model.
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Applying Material Properties (2/2) Material properties can be altered using the following steps:



1
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1. Select the material in the specification tree. 2. Select Properties from the contextual menu. 3. Select the Analysis tab to change the material properties. 4. Click OK to apply the changes to the material properties.
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Viewing Material on the Model You can view the material on the model using a customized view. To view the material use the following step: 1. Click View > Render Style > Shading with Material or click the Shading with material icon. 2. The material is rendered on the model.



1
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Measure the Model In this section you will learn how to use the measurement tools available in CATIA.



Use the following steps: 1. Apply material properties.



2. Measure the Model.
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3. Create formulas and parameters
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Analysis Tools Several tools are available inside the Part Design workbench to analyze a model. There are three types of measure tools in the Measure toolbar: A.



The Measure Between tool measures the distance between the elements in a model.



B.



The Measure Item tool measures a specific element in a model.



C.



A



B



C



The Measure Inertia tool calculates the mass properties of the model.
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All measurements can be saved in the specification tree by selecting the Keep Measure option.
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Element Selection (1/2) When you are selecting elements for measurement, the pointer indicates the type of element being selected. The following types of elements may be indicated: A. B. C. D. E.



Cylindrical surface Plane or planar surface Arc center Line Point



A B



C



D
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This helps to ensure that you are selecting the intended element to measure.
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Element Selection (2/2)



Student Notes:
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Another way to ensure that you are selecting the intended element is to isolate the type of element you want. This is done using the selection mode menus.
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Measure Between Modes Measure between modes tool is used to measure between two elements in a model. There are three different modes: A. In Standard Mode, both the elements must be selected along with their measurements.



A



B. In Chain Mode, the second element selected for a measurement automatically becomes the first element for the next measurement. C. In Fan Mode, measurements are made between the first element and each element selected thereafter.



B
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Measure Between (1/2) Use the following steps to measure between the elements of a model: 1



1. Click the Measure Between icon. 2. Select the Definition type. In this example,



2



Standard Mode is selected. 3. Select the reference element.
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4. Select the target element.



3 4
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Measure Between (2/2) Use the following steps to measure between items in a model (continued): 5. Minimum distance and angle are displayed on the model and in the results dialog box.



5a



6. Select the Keep Measure option to save the measurement. 7. Click OK to complete the measurement. 8. If the Keep Measure option is selected, the measurement remains on the model and is added to the specification tree.



Copyright DASSAULT SYSTEMES



5b 8
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Measure Item (1/2) The Measure Item tool lets you measure individual geometric elements. Use the following steps to measure an item:



1



1. Click the Measure Item icon. 2. Select the geometric element to be measured. 3. The properties of the selected geometric elements are displayed on the model and in the results window.



2
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Measure Item (2/2) Use the following steps to measure an item (continued): 4. Select the Keep Measure option to save the measurement. 5. Click OK to complete the measurement. 6. If the Keep Measure option is selected, the measurement remains on the model and is added to the specification tree.



4
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Components Option (1/2) By default, measurements report the shortest distance between two elements. To obtain the component distances (i.e., distances in the X, Y, and Z directions) relative to a coordinate system, use the following steps: 1. 2.
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3.



Click the Measure Between icon. Select the geometrical elements to be measured. Select Customize and select the Components option. The component distances are displayed in the Results section.
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Components Option (2/2) 4.



5. 6.



The default X, Y, and Z directions are based on the default axis system for the model. To choose an alternate axis system use the Other Axis option. Select Axis System.2 The component distances of the measurement are then based on the selected axis. 4



5



6
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User-defined axis
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Default Axis
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Mass Properties



Student Notes:



A



Mass properties can be calculated using the Measure Inertia tool. This tool can measure the following: A. 3D Properties which are calculated on surfaces (e.g., feature faces) and volumes (e.g., features and PartBodies). B. 2D Properties which are calculated inertia properties on planar 2D surfaces.



B
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The results of 3D and 2D inertia calculations can be customized to report the required results. The Measure Inertia Customization dialog box displays the types of results that can be reported, including mass properties (e.g., volume, mass, and center of gravity).



Copyright DASSAULT SYSTEMES



7-22



CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent Student Notes:



Measure Inertia (1/2) Use the following steps to calculate 3D mass properties with the Measure Inertia tool: 1



1. Select the Measure Inertia Icon. 2. Select the PartBody from the specification tree. 3. Review the results in the display window. 4. The center of gravity is displayed on the model.



2



3
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Measure Inertia (2/2) Use the following steps to calculate 3D mass properties with the Measure Inertia tool (continued): 5. If required, select Customize to change displayed results. 6. Select the Keep Measure option to save the results. 7. Click OK to complete the measurement.



6



7
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Creating Measurement Geometry (1/2)



Student Notes:



All measurement tools have an option to create a geometry. Points, lines, and axis systems can be created to illustrate the measurement. By default, the resulting measurement geometry is associative. If the elements referred by the measurement geometry changes, the same will be updated. This can be made non-associative so that the measurement geometry remains static, when changes occur in the model.



Second point Line
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First point
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Creating Measurement Geometry (2/2) Use the following steps to create measurement geometry:



1
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1. Activate the measurement tool and perform the measurement. 2. Select the Keep Measure option. 3. Select Create Geometry. 4. Select the icon that corresponds to the geometry needed. For example, while performing a Measure Inertia you have the option of creating a point at the center of gravity or at origin of an axis system. 5. Set Associativity. 6. Click OK. 7. Click OK to complete the measurement. 8. The measurement geometry is added to the model and to the specification tree.
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Update



Student Notes:



When the Keep Measure option is selected the measurement is added to the model. Although the measurement is associative, it will not update automatically with changes to the model. If a measurement needs to be updated, the Measurement icon in the specification tree is displayed with the Update symbol, as shown. Right-click on the measurement and click Local Update.
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To automatically update measurements, apply the Automatic Update option from Tools > Options > Infrastructure > Part Infrastructure > General.
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Exercise: Material and Measures



Student Notes:



Recap Exercise 15 min



In this exercise you will take measurements of an existing model. You will practice using the measurement tools and learn when to use each type. Detailed instructions for this exercise are provided. By the end of this exercise you will be able to: Apply material to a model View material on a model Take measurements of an element
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Take measurement in between elements Calculate mass properties of a model
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Do it Yourself (1/11) 1. Open an existing part file. The part used in this exercise has already been created for you.



2a 2b



a. Click Open icon. b. Open Ex7A.CATPart.



2. Apply material to the model. The model is to be made of steel. a. b. c. d. e. f.



2c



Select the part on the specification tree. Click the Apply Material icon. Select the Metal tab. Select Steel. Select Apply Material. Click OK to close the dialog box.
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2e
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Do it Yourself (2/11) 3. View material. To view the material on the model, use the Shading with Material view mode.



3a



a. Click the Shading with Material icon. b. Return back to Shading with Edges.



4. Measure arc length. Use the Measure Item tool to determine the arc length of a filleted corner.



4a



a. Click the Measure Item icon. b. Place the pointer over the arc until the pointer changes to the icon shown. Click to accept the element, and read the results. c. Select the Keep Measure option. d. Click OK to close the dialog box.
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Do it Yourself (3/11) 5. Measure the angle between two elements. Use the Measure Between tool to determine the angle between the bottom surface and the drafted sides. Click the Measure Between icon. Select the bottom surface. Select the side surface. The system calculates the distance between these two elements. e. Click Customize.



5a



a. b. c. d.



5b
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5c
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Do it Yourself (4/11) 5. Measure the angle between two elements (continued). 5f
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f. Clear the Minimum distance/Curve length option and verify that the Angle option is selected. g. Click OK. h. Select the Keep Measure option, if not already selected. i. Click OK.
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Do it Yourself (5/11) 6. Measure between two elements. Use the Measure Between tool to calculate the distance.



6a



a. Select the Measure Between icon. b. Select the side face. c. Place your pointer over the first hole until an infinite line displays; this is the hole’s implicit axis. Click once the axis displays. d. The required measurement is the distance between these two elements in the X direction. Currently, the measurement calculated is the angle between the two elements. 6c
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Do it Yourself (6/11) 6. Measure between two elements (continued…).
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e. Select Customize. f. Select the Components and Minimum distance/Curve length options. Clear the Angle option. g. Click OK. h. Notice that the X, Y, and Z distance are now displayed. Here the X distance is required. By selecting the Keep Measurement option, the components are added to the specification tree. In this case, however, you are required to display the X direction distance directly on the model. To do this, you need to create a reference plane. i. Select Customize and clear the Components option. j. Click OK. k. Click Cancel.
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Do it Yourself (7/11) 7.



Create a reference plane. Create a reference plane through the edge and keep it parallel to the YZ plane so that the distance in the X direction can be calculated and displayed on the model. a.



b.



Select the Plane icon. If you cannot find the icon, type [c:plane] in the power input line. Create a plane, normal to the YZ plane, through the vertex
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Do it Yourself (8/11) 8. Use Measure Between in Fan Mode. Use the Measure Between tool in Fan mode to calculate multiple dimensions. a. b. c. d. e. f. g. h. i.



8b



For clarity, hide the existing measurements. Click the Measure Between icon. Select Measure Between in Fan Mode. Ensure that the Keep Measure option is selected. Select the plane created in the last step as the first element. Select the center of the hole as the next element. Select the center of the next hole as the next element. Select the edge as the final element. Click OK. 8f



8d 8i



8g



8h
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Do it Yourself (9/11) 9. Use Measure Between in Chain Mode. Use the Measure Between tool in Chain mode to calculate multiple dimensions.



9a



a. b. c. d.



Click the Measure Between icon. Select Measure Between in Chain Mode. Ensure that the Keep Measure option is selected. Select the plane created in the last step as the first element. e. Select the center of the hole as the next element. f. Select the center of the next hole as the next element. g. Click OK.



9b



9c
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Do it Yourself (10/11) 10. Calculate Mass Properties. Use the Measure Inertia tool to determine the mass properties of the model.



Copyright DASSAULT SYSTEMES



a. For clarity, hide the existing measurements. b. Select the Measure Inertia icon. c. Select PartBody on the specification tree. The results display. d. Select the Customize icon. e. Calculate only the volume, mass, and the center of gravity. f. Click OK.
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10e



10c



10f
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Do it Yourself (11/11) 10. Calculate Mass Properties (continued). Use the Measure Inertia tool to determine the mass properties of the model. g. Select Create Geometry. h. Create an associative axis system. The created axis system is located at the center of gravity. i. Click OK. j. Click OK in the Measure Inertia window.



11. Save and close the model.



10g 10j
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Exercise Recap: Material and Measures



Student Notes:



Apply material properties View material on the model Take measurements
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Calculate mass properties
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Exercise: Material and Measures



Student Notes:



Recap Exercise 15 min



In this exercise you will use the measurement tools to determine specific dimensions on an existing model. High-level instructions for this exercise are provided.



By the end of this exercise you will be able to: Apply material to a model Take measurements
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Calculate mass properties
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Do it Yourself (1/2) 1. Open Ex7B.CATPart.



3



2. Apply Iron material to the model. 3. View the applied material.



2



4. Determine the width of the part.



Wi



dth
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Do it Yourself (2/2) 5. Calculate the distance between the three center points of the three holes.



7



6. Determine the mass of the model. 7. Measure the angle as shown. 8. Save and close the file. 5
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Exercise Recap: Material and Measures



Student Notes:



Apply material to a model Take measurements
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Calculate mass properties
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Create Formulas and Parameters In this section you will learn how to create formulas in order to maintain the design intent.



Use the following steps: 1. Apply material properties. 2. Measure the model.
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3. Create formulas and parameters



Copyright DASSAULT SYSTEMES



7-45



CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent



Formulas



Student Notes:



All features and elements in CATIA are unique. Once the features are created, they receive a unique identifier (parameter). Unique identifiers are given to dimensions and constraints also. Additional parameters are created for the material, saved measurements, etc. These parameters can be used to create formulas. Formulas are equations that relate one parameter to another and ensure that the design intent is maintained.
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Formulas are stored under the Relations branch of the specification tree. User-defined parameters are stored under the Parameters branch of the tree.
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Identifying Parameters



Student Notes:



Internal identifiers are associated with each parameter in CATIA. It can often be difficult to determine which parameter is required based on its internal identifier. When the Formula window is displayed and a feature is selected the parameters associated with that feature will be displayed in the Formula dialog box. In addition they will be displayed on the model.
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Selecting a parameter from the window will highlight it on the model, and vice versa.
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Creating User-Defined Parameters (1/2)



Student Notes:
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User-defined parameters can contain text information, such as designer, revision date, etc. They can also contain a variety of numerical values. Parameters can be equated to dimensions in your model and be used to drive your design.
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Creating User-Defined Parameters (2/2) Use the following steps to create a userdefined parameter. 1. Click the Formula icon. 2. Select the type of parameter to create from the New Parameter of type list (for example, select the Length type). 3. Click New Parameter of Type icon. 4. Specify a meaningful name. 5. Specify a value. 6. Select Apply. 7. Click OK.



User-Defined parameter is isolated until it is related to some geometric parameter in the model.



1



5



4 3



2 6
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Renaming Parameters Parameters can be renamed using the Formula dialog box. It is helpful to give a to name the parameter such that it is easy to identify it and to understand its function. In addition, a formula which contains the parameter will be easier to understand.



1



Use the following steps to rename a parameter:



Copyright DASSAULT SYSTEMES



1. Select the Formula icon. 2. Locate the parameter in the parameters window. 3. Replace the name in the Edit Name or Value of current parameter field with a more relevant name. 4. Select Apply to confirm the change. 5. Click OK to close the window. It is recommended not to rename a system generated parameter. If the parameter is renamed then you cannot immediately see in which feature it is used. The system generated parameter name includes the path (e.g. Base\Pad.1\FirstLimit\Length), so the location of the parameter is evident.
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5



4
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Filters



Student Notes:



The Formulas and Formula Editor dialog boxes have filters that can be used to find a specific parameter quickly. In the Formula dialog box, you can filter by Name or Type. In the Formula Editor window, you can help narrow the search for the correct parameter using the Dictionary, Members of Parameters, and Members of All columns.
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Use the Renamed parameters filter to display only the parameters that you have renamed in the model.
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Creating Formulas Formulas are commonly used to relate one dimension to another. There are two methods to drive a dimension by a formula: A



A. Use the Formulas dialog box. B. Edit the dimensional value.
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B
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Creating a Formula Using the Formula Dialog Box (1/2) In the example shown, the length of the box is equal to two times the width of the box.



1



Use the following steps to create a formula to drive a dimension using the Formulas dialog box: 1. 2.



3.
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4.



Click the Formula icon Select the feature containing the dimension. All dimensions associated with the selected feature appears on the screen. Select the dimension on the model (e.g., Length). The corresponding dimension is highlighted in the Formulas dialog box. Observe the identifier for the length dimension (PartBody\Sketch.1\Length.8\Length). Click Add Formula button.
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Creating a Formula Using the Formula Dialog Box (2/2) Use the following steps to create a formula to drive a dimension using the Formulas dialog box (continued): 5. Specify the formula. To relate the length dimension to the width dimension, doubleclick the width dimension in the Formula Editor dialog box. (PartBody\Sketch.1\Length.7\Length), or select it on the model. Type [* 2] to equate the length to be twice the width. 6. Click OK. 7. Click OK in the Formulas dialog box. 5
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Creating a Formula by Editing the Dimensional Value (1/2) To define the length of the pad equal to two times the width of the pad using the Dimensional Value dialog box to, use the following steps: 1



Lengt h



1. Edit the feature. 2. Double-click the dimension to edit it (e.g., Length). 3. Right-click on the value field and select Edit formula in the contextual menu.



Width
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Creating a Formula by Editing the Dimensional Value (2/2)



Student Notes:



To define the length of the pad equal to two times the width of the pad using the Dimensional Value dialog box to, use the following steps (continued): 4. Specify the formula. To relate the dimension to another parameter, choose the required parameter in the dialog box or select it using the 3D model. Type [* 2] to equate the length to be twice the width. 5. Click OK. 6. Click OK in the Constraint Definition dialog box.



4



5
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Recommendations for Formulas



Student Notes:
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In this section, you will be given some recommendations that will be helpful while creating formulas.
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Units (1/2) It is important to consider units when you write formulas. If units are not specified in a formula, the default unit is used (i.e., meters). This is particularly important if you are adding or subtracting a numerical value. For example, consider a formula that equates the length of the pad (X) to the width of the pad (Y) + 2mm. If the formula is specifyed as: X=Y+2
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CATIA generates a warning message and assume two meters. This would make the value of X too large.
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Y = 50mm X = Y + 2m = 2050mm
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Units (2/2) Instead, the formula must be specifyed as the following: X = Y + 2mm.
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Y = 50mm
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X = Y + 2mm = 52 mm
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Displaying Formulas and User-Defined Parameters



Student Notes:



User-defined parameters can also be viewed in the specification tree. Click Tools > Options > Infrastructure > Part Infrastructure. Select the Parameters option from the Display tab. Select the Relations option to view formulas.
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The value of parameters can be displayed by clicking Tools > Options > General > Parameters and Measure. Select the With Value option from the Knowledge tab.
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To Sum Up



Student Notes:
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In the following slides you will find a summary of the topics covered in this lesson.
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Apply Material Properties In CATIA you can apply material to any part. These material properties (e.g., density) affects the mass of the part. These properties play important role in the structural and thermal analyses of the part. CATIA has a default library of materials already installed. Your company may have custom materials created to conform to your requirements. You can render the material on the model using a customized view mode or shading with material mode.



Properties important for thermal and structural analyses



Analyze the Model



Rendering after applying material.



There are three types of measure modes: A. The Measure Between tool



Second point



B. The Measure Item tool Line
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C. The Measure Inertia tool All measurements can be saved in the specification tree by selecting the Keep Measure option. All measurement tools have an option to create a geometry. Points, lines, and axis systems related to measurement can be created to illustrate the measurement. This is called as measurement geometry.
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First point



Measurement Geometry
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Create Formulas and Parameters



Student Notes:



All features and elements in CATIA are unique. Once the features are created, they receive a unique identifier (parameter). These parameters can be used to create formulas. Formulas are equations that relate one parameter to another and ensure that the design intent is maintained. Formulas are stored under the Relations branch of the specification tree.
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In addition to system generated parameters you can create new parameters. Such parameters are called as User-Defined parameters. User-Defined parameters are isolated until they are related to some geometric parameter in the model. Userdefined parameters are stored under the Parameters branch of the tree. It is important to consider units when you write formulas. If units are not specified in a formula, the default unit is used (i.e., meters). This is particularly important if you are adding or subtracting a numerical value.
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Main Tools Measure 1



2



3



Measure Between: measures the distance between the elements in a model



1



Measure Item: measures a specific element in a model



2



Measure Inertia: calculates the mass properties of the model



Material 4



3



4



Apply Material: applies material to any part in CATIA



Knowledge 5
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5



Formula: creates new user-defined parameters and creates relation between different parameters



Copyright DASSAULT SYSTEMES



7-64



CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent



Exercise: Parameter and Formula



Student Notes:



Recap Exercise 15 min



In this exercise you will create formulas in an existing part. This exercise will help you to understand how to locate and rename parameters, create new parameters, and create formulas to maintain design intent. You will be creating formulas to maintain design intent of the engine plate. Detailed instruction for this exercise are provided. By the end of this exercise you will be able to: Rename parameters Create new parameters Create user-defined parameters
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Create formulas
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Do it Yourself (1/12) 1. Open an existing part file. To begin, open an existing part file using the open tool.



1b



a. Click File > Open. b. Open Ex7C.CATPart.



2. Create a formula to control sketcher fillets. The four fillets were created inside sketch.1. Create formulas inside the Sketcher workbench to control these fillets together.
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a. Double- click on Sketch.1 to edit it. b. All the fillets must all be 20mm. The fillet on the top right is already correct, so you will use this one to drive the others. c. Double-click the top left fillet dimension to edit it. d. Right-clicking on the Radius field and select Edit Formula.
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2c



2b



2d
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Do it Yourself (2/12) 2. Create a formula to control sketcher fillets (continued…). e. Equate this fillet dimension to the 20mm fillet by selecting the 20mm dimension on the sketch. f. The 20mm parameter gets updated in the Formula Editor. g. Click OK. h. Click OK. i. Create formulas for the other two fillets. Equate them to the fillet on the top right. j. Exit the Sketcher workbench.



2e
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2f
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2g
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Do it Yourself (3/12) 3. Create a parameter. Create a user-defined parameter that is used to control the number of instances in the circular pattern. a. b. c. d. e. f.



3a



Select the Formula icon. Select Integer from the Type list. Select New Parameter of type. Change the name to [No. of Holes]. Set the value to [4]. Click OK.



3d
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3c
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3e 3b



3f
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Do it Yourself (4/12) 4. Add the parameter to the specification tree. The Parameters branch and view options may already be set, verify whether they are correct.



4c



a. Click Tools > Options. b. Select Infrastructure > Part Infrastructure. c. Select the Display tab. d. Display all the information in the specification tree.



4d
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Do it Yourself (5/12) 4. Add the parameter to the specification tree (continued…). e. Click General > Parameters and Measure. f. Select the Knowledge tab. g. Select the With Value option. h. Click OK. i. Observe the Parameters branch in the tree. When it is expanded, the parameter you created is displayed along with its value.



4f 4g 4e



4h
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Do it Yourself (6/12) 5. Equate the pattern instance parameter to the No. of Holes parameter. Create a formula to equate the pattern instance with the new user-defined parameter. a. b. c. d.



5a



Click the Formula icon. Select the pattern. Select PartBody\CircPattern.1\AngularNumber. Click the Add Formula button.



5c
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5d
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Do it Yourself (7/12) 5. Equate the pattern instance parameter to the No. of Holes parameter (continued…).
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e. From the Members of Parameters column, select Renamed parameters. f. Double-click No. of Holes. g. Click OK. h. The Pattern Instance parameter is now equal to the No of Holes parameter. Click OK. i. Test the formula by double-clicking on the No of Holes parameter and by changing the value to [6].
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5e



5g



5i



7-72



CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent Student Notes:



Do it Yourself (8/12) 6. Rename parameters. To help locate parameters faster and to rename them. a. b. c. d. e.



Click the Formula icon. Select Pad.1 to display only its parameters. Select PartBody\Sketch.1\Offset.7\Offset. Rename the parameter to [Length]. Click Apply.



6a



6c
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Do it Yourself (9/12) 6. Rename parameters (continued…). f. Select PartBody\Sketch.1\Offset.5\Offset. g. Rename the parameter to [Width]. h. Click Apply. i. Click OK.



6f
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Do it Yourself (10/12) 7. Create a formula. Create a formula that equates the width and the height of Pad.1. a. Double-click Pad.1 to edit. b. Double-click the Length dimension. c. Right-click on the Value field and select Edit formula. d. Select the Width dimension. e. Click OK f. Click OK from the Constraint Definition window. g. Click OK from the Pad Definition window.



7d



7b
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Do it Yourself (11/12) 8. Create a formula. Create a formula that equates the thickness of the model to 0.05 times the length. a. b. c. d. e. f.



Select the Formula icon. Select the pad. Select the parameter with value 5mm. Rename the parameter to [Thickness]. Click Apply. Click Add Formula.



8a



8c
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Do it Yourself (12/12) 8.



Create a formula (continued…). g. Select the Width dimension. h. Add [* 0.05] to the formula. This means the thickness will be equal to 0.05 of the part length. i. Click OK j. Click OK from the Formulas dialog box. k. Edit the Width dimension to 200mm. Does the thickness and length update correctly?



9.



8h 8g



Save and close the part.
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Exercise Recap: Parameter and Formula



Student Notes:



Rename parameters Create new parameters Create user-defined parameters
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Create formulas
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Exercise: Parameter and Formula



Student Notes:



Recap Exercise 20 min



In this exercise you will practice maintaining design intent by creating formulas and parameters. You will use the tools used in the previous exercises to complete this exercise. High-level instructions for this exercise are provided. By the end of this exercise you will be able to: Create formulas
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Create user-defined parameters



Copyright DASSAULT SYSTEMES



7-79



CATIA V5 Fundamentals- Lesson 7: Finalizing Design Intent



Do it Yourself (1/7) Open Ex7D.CATPart. Open an existing part file using the Open tool.



2.



Review the model. Review the model creation. Are there any existing formulas?
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1.



Student Notes:
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Do it Yourself (2/7) 3. Control all Pad.1 dimensions with the width. Create formulas so that changing the width of pad.1 also updates the radius and the length. The radius should be 8% of the width and the length should be 75% of the width.



Width



Length



3
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Do it Yourself (3/7) 4. Create a formula. Create a formula to link the diameter of the co-axial hole with the outside radius. The co-axial hole’s diameter should be two- third (2/3) of the outside radius. Outside radius
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Do it Yourself (4/7)



Student Notes:



The next two steps are used to create a formula that controls the radius of EdgeFillet.2 based on the arc length of EdgeFillet.1. 5. Measure arc length of the edge fillet. In order to use a measurement in a formula, you must create the measurement before creating the feature where you want to use it. As a workaround, define EdgeFillet.1 as the object and take the measurement. By doing this, the measurement comes before EdgeFillet.2 in the regeneration cycle:
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a. Right-click on EdgeFillet.1 and select Define in Work Object. b. Calculate the arc length of EdgeFillet.1. You will need to customize the measurement to calculate the length. c. Save the measurement in the specification tree.
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Do it Yourself (5/7) 6. Create a formula. Create a formula that equates the radius of EdgeFillet.2 to one-third (1/3) the arc length measured in the last step.
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Do it Yourself (6/7) 7. Create a user-defined parameter. Type = [Length] Name = [Width] Value = [200mm]



7



8. Equate the width of the part to the new Width parameter. Set the Width dimension (PartBody\Sketch.1\Offset.28\Offset) of Pad.1 equal to the new parameter.
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Do it Yourself (7/7)



Student Notes:



9. Test the model. Change the Width parameter to [150mm] and change the radius of EdgeFillet.1 to [5mm]. Update the model. Did the model update as expected?
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10. Save and close the file.
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Exercise Recap: Parameter and Formula



Student Notes:



Create formulas
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Create user-defined parameters
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Exercise: Parameter and Formula



Student Notes:



Recap Exercise 15 min



In this exercise, you will create formulas and parameters to control dimensions in the model. You will use the tools you have learned in this lesson to complete the exercise with no detailed instructions. By the end of this exercise you will be able to: Rename parameters Create formulas
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Create user-defined parameters
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Do it Yourself (1/3) 1. 2.



Open Ex_7E.CATPart. Rename the following parameters to create the formulas: Current Name



New Name



a.



PartBody\Pad.1\FirstLimit\Length



Thickness



b.



PartBody\Sketch.1\Offset.41\Offset



Pad.1 Length



c.



PartBody\Sketch.1\Radius.13\Radius



SmallArc Radius



d.



PartBody\Sketch.1\Radius.14\Radius



LargeArc Radius



e.



PartBody\Hole.2\Diameter



Hole Diameter



f.



PartBody\EdgeFillet.2\CstEdgeRibbon.16\Radius



Fillet Radius 2e



2d 2b 2a
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Do it Yourself (2/3)



Student Notes:



3. Create a parameter. Type = [Length]. Name = [Length]. Value = 180mm].
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4. Create the following formulas: LargeArc Radius = 10% of Length. SmallArc Radius = 2 3 LargeArc Radius. Thickness = 2.5% Length. Hole Diameter = LargeArc Radius. Fillet Radius = ½ Thickness. Pad.1 Length = Length.
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Do it Yourself (3/3) 5. Test the model. a. Change the length parameter to a value of [300mm]. b. Use the Measurement tool to calculate the new distance between the center of the large arc and the center of the small arc.



5a
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Exercise Recap: Parameter and Formula



Student Notes:



Rename parameters Create formulas
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Create user-defined parameters
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Case Study: Finalizing Design Intent



Student Notes:



Recap Exercise 30 min



You will practice what you learned by completing the case study model using only a detailed drawing as a guidance. In this exercise, you will create the case study model. Recall the design intent of this model: The model must be made of aluminum. Create a hole that is centered on the part horizontally and 2mm above the top of the bottom oblong holes. When modifications are made to the model:
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Overall width must be 80% of the length (L). Thickness of the model is always 1% the length (L) of the model. The thickness of the ribs is 2 times the thickness of the model.



Using the techniques discussed so far, create the model without detailed instructions.
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Do It Yourself: Finalizing Design Intent (1/5) Use the following steps as hints to create the model: 1. Open CS_L7.CATPart. 2. Create a 20mm diameter hole with the following requirements: Hole must remain 2mm above the top of the bottom oblong holes. a. To do this, you can create a measurement to calculate the distance from the bottom of the model to the top of the bottom oblong holes. For the measurement a point has already been created.



Hole must remain centered horizontally on the model.
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a. This model has been created symmetric about the YZ plane.
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Do It Yourself: Finalizing Design Intent (2/5) 3. Rename the parameters and create formulas to maintain the required design intent. The completed model is shown.



Length
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Formula2
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Do It Yourself: Finalizing Design Intent (3/5) 4. Rename the parameters and create formulas to maintain the required design intent. The completed model is shown.



Formula3



Formula4
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Do It Yourself: Finalizing Design Intent (4/5)



Student Notes:
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5. Calculate the volume and mass of the model. Create an associative point at the center of gravity.
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Do It Yourself: Finalizing Design Intent (5/5)



Student Notes:



Copyright DASSAULT SYSTEMES



6. Modify the length of the model to [500mm]. Calculate the distance between the center oblong hole and the side wall.
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Case Study: Finalizing Design Intent Recap



Student Notes:



Apply material to the model Calculate mass properties Create formulas
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Take measurements
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